
www.Fisher.com

Настройка цифрового контроллера клапана
Fisher™ FIELDVUE™ DVC6200p, доступ к
настройкам подключения и калибровки с
помощью ПО Siemens SIMATIC
Manager/PDM
Содержание
Документы по теме 2. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Подключение цифрового контроллера клапана

DVC6200p с помощью расширенного описания
устройства (EDD) для Siemens SIMATIC PDM 3. . . .

Настройка интерфейса PG/PC 4. . . . . . . . . . . . . . . . . . .
Загрузка DVC6200p EDD в каталог SIMATIC 

Manager/PDM 8. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Настройка устройства с помощью ПО Siemens 

SIMATIC PDM 11. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Переход в онлайн-режим с помощью DVC6200p 17. . .

Выполнение быстрой локальной настройки и 
калибровки цифрового контроллера клапана 
DVC6200p 19. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

В этом документе приведено описание процедур настройки и доступа к DVC6200p с помощью программного
обеспечения Siemens SIMATIC PDM, а также процессов первоначальной настройки приводов и клапанов, калибровки
и регулировки с помощью процедуры пошаговой установки.

Процедуры, рассматриваемые в этом дополнении к руководству, были выполнены с помощью ПО Siemens SIMATIC
Manager/PDM 9.1. Хотя выполняемые действия в целом не должны отличаться, но при использовании другой версии
программного обеспечения экраны могут выглядеть несколько иначе.

Убедитесь в доступности всех необходимых файлов, включая последнюю версию расширенного описания устройства
(EDD) DVC6200p.

Примечание

Как правило, настройку интерфейса PG/PC и загрузку расширенного описания устройства DVC6200p требуется

выполнять один раз для каждого компьютера.

Информацию об установке, подключении и первоначальной настройке DVC6200p см. 
в кратком руководстве по эксплуатации устройства серии DVC6200 (D103556X0RU). 
Если требуется копия данного краткого руководства по эксплуатации, отсканируйте 
или щелкните код QR справа, обратитесь в торговое представительство компании 
Emerson Automation Solutions или посетите наш веб-сайт по адресу www.Fisher.com.

Дополнение к руководству по эксплуатации
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Отсканируйте
или щелкните 

для обращения
в местную
службу
поддержки

http://www.emerson.com/documents/automation/Quick-Start-Guide-Fisher-FIELDVUE-DVC6200-DVC6200-Series-Digital-Valve-Controllers-Russian-ru-122588.pdf
https://www.emerson.com/documents/automation/fisher-fieldvue-dvc6200p-field-support-en-190026.pdf
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Документы по теме
� Краткое руководство по эксплуатации цифрового клапана Fisher серии FIELDVUE DVC6200 (D103556X0RU)

� Цифровой контроллер клапана Fisher FIELDVUE DVC6200p. Руководство по эксплуатации (D103563X012)

Все эти документы можно получить в торговых представительствах компании Emerson. Также посетите наш веб-сайт
по адресу www.Fisher.com.

http://www.emerson.com/documents/automation/Quick-Start-Guide-Fisher-FIELDVUE-DVC6200-DVC6200-Series-Digital-Valve-Controllers-Russian-ru-122588.pdf
http://www.emerson.com/documents/automation/FIELDVUE-DVC6200p-Digital-Valve-Controller-en-123474.pdf
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Подключение цифрового контроллера клапана DVC6200p
с помощью расширенного описания устройства (EDD) для
Siemens SIMATIC PDM
См. рис. 1.

Рис. 1. Подключение цифрового контроллера клапана FIELDVUE DVC6200p с помощью расширенного
описания устройства (EDD) для Siemens SIMATIC PDM
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Настройка интерфейса PG/PC

Примечание

Настройка интерфейса PG/PC на плате PC (CP 5711 или аналогичной плате PROFIBUS) выполняется однократно

после первичной физической установки платы в корпус компьютера.

1.  Элемент Set PG/PC Interface (Настройка интерфейса PG/PC) появляется на панели управления ПК после установки
ПО Siemens STEP 7 или SIMATIC Manager/PDM. 

а.  Перейдите к элементу Set PG/PC Interface (Настройка интерфейса PG/PC), как показано на рис. 2.

б.  В меню Interface (Интерфейс) выберите пункт Select... (Выбрать), чтобы добавить плату PROFIBUS типа
PCI/PCMCIA/USB, установленную в ПК.

в.  После того как интерфейс или плата отобразится (см. рис. 2), выберите установленный адаптер интерфейса и
щелкните пункт Properties (Свойства). В этом примере выбран элемент PC Adapter USB A2.PROFIBUS.1 <Active>
(Адаптер ПК USB A2.PROFIBUS.1 <Активный>).

Для получения более подробной информации о настройке интерфейса PG/PC посетите следующий сайт Siemens:

http://support.automation.siemens.com/WW/view/en/25471997

Рис. 2. Настройка интерфейса PG/PC

ВЫБЕРИТЕ
АДАПТЕР
ИНТЕРФЕЙСА
PROFIBUS
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2.  Если плата PROFIBUS является единственным ведущим устройством на шине, то интерфейс PG/PC также должен
быть единственным ведущим устройством (выберите элемент PG/PC is the only master on the bus (PG/PC является
единственным ведущим устройством на шине)) - см. рис. 3. Если на шине имеются другие ведущие устройства
класса 1 или 2, то НЕ задавайте интерфейс PG/PC как единственное ведущее устройство. В разделе Network
Parameters (Параметры сети) выберите надлежащую скорость передачи данных по шине. После задания всех
параметров щелкните OK.

Рис. 3. Настройка параметров платы PROFIBUS

НАСТРОЙКИ
ПАРАМЕТРОВ

Примечание

Приведенные выше параметры распространяются только на тот случай, когда плата PG/PC является единственным

ведущим устройством на шине.
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3.  Щелкните кнопку Diagnostics... (Диагностика), как показано на рис. 4.

Рис. 4. Diagnostics... (Диагностика)

4.  В окне Diagnostics (Диагностика), которое показано на рис. 5, щелкните Test (Тест) для проверки состояния платы
PROFIBUS и сети.

Рис. 5. Диагностика состояния/сети - тест
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5.  Убедитесь, что установлено состояние OK (см. рис. 6.) Если тест завершился состоянием Failed (Сбой), то,
возможно, потребуется изменение параметров, заданных при выполнении шага 2.

Примечание

Если тест завершился неудачно, то проверьте тип используемого блока сопряжения DP/PA, а также соответствие

заданных параметров рекомендуемым производителем значениям.

6.  Чтобы определить адрес узла и подключенных устройств, щелкните кнопку Read (Чтение), как показано на рис. 6.

Рис. 6. Диагностика состояния/сети

СОСТОЯНИЕ
ТЕСТА

ЧТЕНИЕ

7.  Все подключенные ведущие и ведомые устройства отобразятся в соответствующих полях (в примере,
приведенном на рис. 7, плата PROFIBUS подключена к адресу 4). Ведущие устройства шины обозначаются как
Station Active (Активная станция). Ведомые устройства обозначаются как Station Passive (Пассивная станция).
Активный ПЛК (ведущее устройство класса 1) обозначается как Station Active Ready (Поддержка активной станции).
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Рис. 7. Диагностика состояния/сети - адрес станции

АДРЕС СТАНЦИИ

УЗЕЛ ШИНЫ 55

Примечание

Стандартный адрес DVC6200p, устанавливаемый на заводе, - 126.

Примечание

В приведенном выше примере ведомое устройство было найдено на узле шины 55, а ведущее устройство класса 2

расположено на адресе 4.

Запишите адреса, определенные в ходе сканирования узлов шины, для дальнейшего использования.

Примечание

Внесение каких-либо изменений в данные на других вкладках не требуется.

8.  Чтобы закрыть окно Set PG/PC (Настройка PG/PC), нажмите кнопку OK.

Загрузка DVC6200p EDD в каталог SIMATIC Manager/PDM

Откройте Device Integration Manager - Siemens.

Загрузите файл расширенного описания устройства (EDD) из исходного каталога или из сжатого архива, как показано
на рис. 8. Перейдите к файлу EDD, выделите и выберите элемент Open (Открыть), чтобы добавить EDD в каталог
(см. рис. 9).
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Рис. 8. Загрузка файла EDD

ИСХОДНЫЙ
КАТАЛОГ

СЖАТЫЙ
АРХИВ

ИЛИ

ПЕРЕЙДИТЕ К
ФАЙЛУ EDD
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Примечание

Загрузить файл EDD для конкретного устройства (например, DVC6200p) в SIMATIC PDM необходимо лишь единожды

- если только не потребуется ввести новый или обновленный файл EDD.

Рис. 9. Файл EDD, загруженный в Device Integration Manager

ФАЙЛ EDD, 
ЗАГРУЖЕННЫЙ
В КАТАЛОГ
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Настройка устройства с помощью ПО Siemens SIMATIC PDM
Перед началом настройки устройства убедитесь в правильности установки прибора и всех электрических и
пневматических соединений. Для получения общих рекомендаций по монтажу см. краткое руководство по
эксплуатации или инструкции по установке, входящие в комплект поставки крепежного комплекта. Сведения о
пневматических и электрических соединениях также можно найти в кратком руководстве по эксплуатации.

  ПРЕДУПРЕЖДЕНИЕ

Изменения настроек прибора могут привести к изменению давления на выходе или величины хода клапана. В
зависимости от сферы работы такие изменения могут обернуться нарушением технологического процесса, что, в
свою очередь, может привести к получению травм персоналом и/или материальному ущербу.

1.  Запустите приложение SIMATIC Manager с помощью ярлыка на рабочем столе Windows или в меню Пуск. Чтобы
создать новый проект, воспользуйтесь меню File > New (Файл > Создать), как показано на рис. 10. Введите
название проекта или откройте существующий пользовательский проект и выберите OK. По умолчанию проект
сохраняется в каталог программных файлов SIEMENS, как показано ниже; однако, если файл проекта уже
существует, можно задать иной путь.

Рис. 10. Создание нового проекта

КАТАЛОГ СОХРАНЕНИЯ
ФАЙЛОВ ПО УМОЛЧАНИЮ

НАИМЕНОВАНИЕ
ПРОЕКТА

http://www.emerson.com/documents/automation/Quick-Start-Guide-Fisher-FIELDVUE-DVC6200-DVC6200-Series-Digital-Valve-Controllers-Russian-ru-122588.pdf
http://www.emerson.com/documents/automation/Quick-Start-Guide-Fisher-FIELDVUE-DVC6200-DVC6200-Series-Digital-Valve-Controllers-Russian-ru-122588.pdf
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2.  Щелкните правой кнопкой мыши проект на левой панели и выберите пункт Insert New Object > networks (Вставить
новый объект > сети) (если сети пока отсутствуют).

Рис. 11. Добавление сетей

НАИМЕНО-
ВАНИЕ 
ПРОЕКТА

3.  Щелкните правой кнопкой мыши значок сетей на правой панели и выберите пункт Insert New Object >
Communications Network (Вставить новый объект > Сеть передачи данных), как показано на рис. 12.

Рис. 12. Добавление сети передачи данных
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4.  Введите название объекта, а затем щелкните Assign Device Type (Присвоение типа устройства), как показано ниже.
Перейдите к сети PROFIBUS DP и выберите OK.

Рис. 13. Присвоение типа устройства
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5.  Новая сеть теперь отображается на правой панели, как показано на рис. 14. Щелкните сеть правой кнопкой мыши и
выберите Insert New Object > Object (Вставить новый объект > Объект).

Рис. 14. Вставка объекта
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6.  Введите название объекта (например, имя тега) и задайте адрес PROFIBUS. Щелкните Assign Device Type
(Присвоение типа устройства). Выберите PA Standalone (Автономный блок PA) для автономной станции PDM или
PA Step7, если PDM устанавливается в интегрированной среде. Щелкните кнопку OK. Щелкните кнопку OK на
появившемся в результате экране.

Примечание

Стандартный адрес DVC6200p, устанавливаемый на заводе, - 126. В зависимости от конкретных требований

технологического процесса может потребоваться его изменение.

Рис. 15. Задание адреса PROFIBUS
ЗАДАНИЕ ПРЕДПОЛАГАЕМОГО АДРЕСА ПРОЕКТА

ВАЖНОЕ ПРИМЕЧАНИЕ!

В ЭТОМ ПОЛЕ ЗАДАЕТСЯ
ТРЕБУЕМЫЙ АДРЕС
УСТРОЙСТВА, КОТОРЫЙ
ДОЛЖЕН СОВПАДАТЬ С
ПРЕДПОЛАГАЕМЫМ
АДРЕСОМ ПРОЕКТА,
УКАЗАННЫМ ВЫШЕ
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7.  Щелкните правой кнопкой мыши устройство на правой панели и выберите пункт Open Object (Открыть объект), как
показано на рис. 16.

Рис. 16. Меню Open Device (Открыть устройство) в SIMATIC PDM

8.  На появившемся в результате экране меню Offline (Автономный режим) (рис. 17) выберите значок Upload
(Загрузить), как показано ниже, чтобы загрузить устройство в базу данных. Щелкните кнопку Start (Пуск). По
завершении загрузки появляется имя тега. Закройте диалоговое окно Upload PG/PC (Загрузка PG/PC).

Примечание

Устройство необходимо загружать в базу данных только с помощью значка Upload (Загрузить); не выполняйте

загрузку из раскрывающегося меню.

Рис. 17. Загрузка устройства в базу данных

ЗАГРУ-
ЗИТЬ

ЗАПУСК ЗАГРУЗКИ

ИМЯ ТЕГА

ЗАВЕРШЕНИЕ ЗАГРУЗКИ

АВТОНОМНЫЙ
РЕЖИМ

Теперь настройка проекта завершена, и можно установить соединение с DVC6200p. Перейдите к процедуре Переход
в онлайн-режим с помощью DVC6200p, описанной на следующей странице.
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Переход в онлайн-режим с помощью DVC6200p
1.  Щелкните Device > Online (Устройство > Онлайн-режим) для доступа к DVC6200p EDD, как показано на рис. 18.

Рис. 18. Переход в онлайн-режим
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Для получения информации об интерфейсе окна Overview (Обзор) см. рис. 19. В окне Overview (Обзор) отображаются
первичные переменные, состояние и режим работы устройства. Оно также позволяет ввести серийный номер
устройства и получить доступ к информации об устройстве, клапану рабочего хода и процедурам калибровки.

Рис. 19. Обзор FIELDVUE DVC6200 EDD

ДАННАЯ КНОПКА ПОЗВОЛЯЕТ
ИЗМЕНИТЬ РЕЖИМ РАБОТЫ

СОСТОЯНИЕ УСТРОЙСТВА - ЩЕЛКНИТЕ
ДЛЯ ПРОСМОТРА СООБЩЕНИЙ ПО 
АКТИВНОМУ СОСТОЯНИЮ

2.  Чтобы настроить DVC6200p, выберите пункт Configure > Guided Setup (Настройка > Пошаговая настройка по
инструкции) и перейдите в окно Device Setup (Настройка устройства), как показано на рис. 20. Следуйте
инструкциям для настройки информации о приводе и клапанах, калибровки и регулировки узла клапана. Если
настройка устройства осуществляется перед установкой устройства, см. примечание на следующей странице.

Рис. 20. Переход к окну Device Setup (Настройка устройства)

ПОШАГОВАЯ
НАСТРОЙКА
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Примечание

Автоматическая калибровка и регулировка являются частью процедуры настройки устройства. Однако, если

физическое подключение DVC6200p к приводу/узлу клапана отсутствует, выполнение процедур автоматической

калибровки и настройки невозможно. Если настройка устройства выполняется перед установкой, выполните

процедуру настройки устройства до этапа автоматической калибровки и выберите элемент Cancel (Отмена), как

показано на рис. 21. После установки DVC6200p на привод/узел клапана можно выполнить калибровку и регулировку

с помощью процедуры быстрой локальной настройки и калибровки, которая приведена ниже.

Рис. 21. Select Calibration Type > Cancel (Выбрать тип калибровки > Отмена)

Выполнение быстрой локальной настройки и калибровки
цифрового контроллера клапана DVC6200p

Примечание

Данный метод калибровки используется в тех случаях, когда в сети нет ведущих устройств класса 2 (например,

SIMATIC PDM) или другого программного обеспечения для настройки.

  ПРЕДУПРЕЖДЕНИЕ

Изменения настроек прибора могут привести к изменению давления на выходе или величины хода клапана. В
зависимости от сферы работы такие изменения могут обернуться нарушением технологического процесса, что, в
свою очередь, может привести к получению травм персоналом и/или материальному ущербу.

  ПРЕДУПРЕЖДЕНИЕ

Во время калибровки клапан выполняет полный ход. Во избежание получения травм персоналом и материального
ущерба вследствие выхода технологической среды под давлением изолируйте клапан от технологического процесса
и выровняйте давление по обеим сторонам клапана либо стравите технологическую жидкость.
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Калибровку перемещения и автоматическую настройку можно также выполнить путем замыкания вспомогательных
терминальных соединений, показанных на рис. 22, на промежуток времени от 3 до 10 секунд. Прекратить выполнение
этой процедуры можно путем замыкания вспомогательных клемм накоротко на 1 секунду. Во время этой процедуры
также считывается диапазон значений давления.

Рис. 22. Замыкание вспомогательных терминальных соединений накоротко

Примечание

Если цифровой контроллер клапана подключен к SIMATIC PDM, то в окне обзора EDD будет отображаться процесс

калибровки.

Примечание

Продолжительность калибровки зависит от типа и размера привода. Для привода Fisher 667 типоразмера 30

стандартное время калибровки составляет приблизительно 4 - 5 минут.
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